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Using FACTS

Using FACTS provides general information about the basic features of
each major program in the system.

FACTS leads the distribution industry with more than 4,300
installations.

Its suite of 22 highly integrated modules address the needs of
distributors in the areas of Electronic Commerce, Asset Management,
Financial Management and Customer Service.

FACTS ties together all of your business processes. Quotes convert
easily into sales orders, while Purchasing gets automatic notification of
any special order needs.

Key advantages

Immediate access to information. You are not required to memorize
codes to locate information in FACTS. Using the search feature, you can
quickly find and select information from a list, no matter how long it is.
A variety of sort orders, filter options and multiple keywords help you
pinpoint the information you need.

Maximum value, low cost of ownership. FACTS carries the lowest
overall total cost of ownership in the industry. Technologies such as the
Client Interface Service (CIS) and component -based architecture help
keep hardware costs down and make it cost effective to customize the
system to your company's needs.

Local Sales and Service. FACTS is supported by direct offices in
selected cities and an unbeatable network of Authorized Affiliates
located across the U.S. and Canada. With this team of more than 500
professionals dedicated to the success of FACTS in your business, we
provide the best and most cost-effective local sales, service and support
in the industry.

FACTS User Basics

Basic system structure

The FACTS system is a suite of 22 highly integrated modules that
address asset management, customer service, financial management
and electronic commerce. The modules are:

e Accounts Payable ¢ Manufacturing Control
e Accounts Receivable e Payroll
e Archive e Purchase Orders
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e EDI e Report Writer

¢ Executive Information System e Sales Analysis

¢ FaxLink with VSI-FAX e Sales Orders

e General Ledger e Service & Repair

e Internet On-Ramp ¢ Shipping for UPS (Clippership)
¢ Inventory Control ¢ System Management

e Job Cost e Unform

Each of the FACTS modules contains a complement of programs to
help you manage these four major business categories. The six types of
FACTS programs are:

¢ Entries o File Maintenances
e Reports, Registers & Updates e Searches
o Inquiries e Selectors/menus

Entry programs (E) enable you to enter data transactions into the
system. For example, to enter an order, purchase order or accounts
payable invoice you will use an entry program.

File maintenance (F) programs form the foundation of the FACTS
system. Use these programs enable you to set controls and parameters.
They also allow you to enter vital information that can later be recalled
throughout the system. For example, information about customers,
items and vendors is entered and maintained by using file maintenance
programs.

Inquiry (I) programs allow you to look up review information stored in
the system. Notes may be entered for customers, vendors, items,
employees and banks. Notes are entered through the appropriate
inquiry program or the Notes Entry (SME710) program. Notes are
displayed in inquiry programs, Sales Orders and Purchase Orders entry
programs, Item F/M (ICF910) and Customer F/M (ARF910), and print
on the appropriate notes report.

Print (P) programs are used to print forms, such as invoices, checks and
statements. These types of programs frequent output to preprinted
forms, or they can be output via Unform.

Report or register (R) programs are used to print information in report
format. Reports print information, but they do not update the system.
The Open Receivables Report is an example of this type of program. On
the other hand, registers print a report and then offer you the option to
update, or post the register information to the appropriate files. For
example, the SO Daily Sales Register lists all the invoices that have been
printed since the last time you ran the register. If you choose the
optional update the register offers, the invoices then post to the open
receivables file, sales tax file, etc.

Update (U) programs only update information throughout the system.
They do not produce a report. An example is the AR End-of-Period
Update program, which you run to close out the Accounts Receivable
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for the period. This update increments the AR period, zeroes out
month-to-date sales figures, etc.

Selector or menu (S) programs enable you to navigate through the
FACTS system so you can access the programs you need.

Assuming your system has not been modified, the FACTS Master Menu
is the first menu you see after you sign into the system.

To tell which type of program you're in, look at the program
designation in the title bar.

L% PO Statuz Report [POR710)

The third letter in the designation indicates the program type. In this
case, the program is a report.

The program designation also appears in the upper-right hand corner
of the menus when you highlight a program in the left navigation
panel.

Program designations provide other useful information. The first two
letters represent the module code. The digits at the end of the
designations represent program numbers. They also indicate on which
menu the program can be found.

For instance, if the Purchase Orders Reports menu designation is
POS700, then all the programs on that menu will start with a 7 as well.

Important Keys

The keys marked F1, F2, F3 and F4 or [, II, IIl and IV (depending on the
keyboard) are the function or control keys. If these keys provide an
operation in the programs being used, the key number and its
operation are displayed in the user prompt. For example, normally the
F4 key backs up to the previous input. These keys are functional when
the user prompt gives the option to use them. When the user presses
the function key, the function displayed in the prompt is executed
immediately without the user having to then press CR or enter. A
displayed prompt might be F4 - Backup. Whenever F4 is displayed it
always means the user may back up to the previous input or end the
program depending on what the prompt displays. Other examples of
these keys are F3 - to display the next record in a file, F4 - end the
program or F2 - perform a search.

Also note that CR in prompts refers to the ENTER or RETURN key on
the keyboard. For example, when entering data, the user types the data
and then presses CR. Once again, when using a function key, pressing
CR is not necessary. If the prompt gives the option of F4-end, and F4 is
pressed, the program ends immediately.

On-Line Access and Edit Keys

While signed into FACTS, there are specific on-line functions that can
be accessed by pressing a “Hot Key.” The “Hot Keys” that invoke the
functions are defined by terminal in the Terminal F/M option in the
System Management Module. The available functions are:

On-Line Calendar

You can invoke the on-line calendar from anywhere in the system by
pressing the hot key defined to it. The default hot key for the FACTS
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System is CTL+D, but you can change this in the Terminal F/M Screen.
You can also copy a date into the system from the calendar by pressing
the F3 key if you are in a date field.

Date Calendar

Date fields in FACTS can now display a calendar pop up window. To display the calendar

press Shift F2 in any date field.
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On-Line Calculator

You can invoke the on-line calculator from anywhere in the system by
pressing the hot key defined to it. The default hot key for the FACTS
system is CTL+V, but you can change this on the Terminal F/M Screen.
You can also copy a total from this calculator into any amount field in
the system by pressing the F10 key. This calculator operates similar to
an adding machine in that the operation (+, -, x, / or *) be entered prior
to entering the number.

SO Quick Look

You can invoke a quick search from the SO entry programs by pressing
the hot key defined to it. The default hot key for the FACTS system is
CTL+B, but you can change this on the on the Terminal F/M Screen.
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Using the PDF Manuals

Each FACTS module has its own manual, which is distributed in
Acrobat PDF format on the PDF Documentation Library CD.

FACTS Manuals are distributed in PDF format to allow you greater
flexibility. You can choose to:

e Print the entire set of manuals at a copier service, such as Kinkos,
AlphaGraphics or Sir Speedy. The license agreement allows you to
print a set of manuals for each license purchased. So if you
purchased a five-user license, you can print five sets of manuals.

e Print the section or pages you need as you go. This is the beauty of
electronic documentation distributed on CD-ROM. You decide how
much paper you want to use. Find the parts of the documentation
you need, or want to keep handy, and output those pages to your
office printer.

¢ Go paperless. Copy the PDF library to a network drive or to a
user’s local hard drive so they can use the documentation like an
electronic library.

You may want to start with the Welcome?7 page, which provides links
to each of the manuals via their Table of Contents. The page also
provides basic instructions for printing the manuals and using the
Search feature to find topic

How the manuals are organized

All of the FACTS manuals contain the following sections: system
overview, program descriptions, references, glossary of terms, and
sample reports. The System Management manual includes sections on
Job Stream and Office Automation.

Table of Contents

The TOCs in each manual reflect the menu structure used in FACTS.
This makes it easy to find a program if you know which menu it’s on.

Preface

These sections provide general information about the manual and
preprinted forms.

System Overview

These sections often include an overview of the module, a list of
program features, definitions of important terms used in the module, a
general process flow, and recommended operating procedures. Flow
charts help illustrate the information flow through the programs and
the modules interaction with other FACTS modules.

Program descriptions

These chapters detail each program in the module and comprise the
bulk of the content for each manual. Each program description
includes the functions, user inputs, technical notes and a screen print.
The programs are listed in the order that they appear on the menu.
There is an overview preceding each menu that explains the interaction
of the programs within the menu.
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Procedures

For many entry, register, and inquiry programs, the topics containing
the phrase “How to” in the topic title are step-by-step procedures for
using the program.

References (Appendix A)

Throughout the documentation the phrase (ref. #) is used to refer to the
Appendix called “References.” References are generic notes that may
apply to more than one prompt or feature throughout the manual.
References are used to prevent the same information from being
repeated one program to the next. The notes are consolidated in the
Appendix and referenced throughout each manual.

Glossary of Terms (Appendix B)

The glossary provides a definition of terms used in the manual and
related terms from other modules.

Sample Reports (Appendix C)

This section provides a sample printout of most of the reports and
prints in the module. A directory is included that lists each report and
the page number in the section.

Conventions used in the manuals
The following elements are used through the FACTS documentation.

= Indicates a statement or paragraph that is critical
to the installation process.

bold items When used in a set of instructions, bold type
indicates items that need to be selected, such as
directories, files, buttons, etc.

Start DPrograms ZWind X Italicized words connected by arrows indicate a
series of selections you need to make to reach a
menu item either in FACTS or Windows.

Boxed text in margins | Contain important background information, such
as terminology or technical tips.
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Backing up the system

Your company’s computer system represents a major investment. This
investment needs to be protected as much as possible. You can protect
your computer hardware through preventive maintenance periodically
provided by your hardware vendor.

Similarly, you can protect your software investment by performing
routine backups. A backup is the replication of information in your
computer system onto media such as cartridge tapes or diskettes.
Think of backups as insurance: in the event of hardware failure, fire,
electrical failure, user errors, theft or any other acts of God (tornado,
hurricane, flood, lightening, etc.), it is great to have the insurance to
bear the financial burden.

The more frequent the backup, the better the insurance. If you lose data,
through hardware problems or through user error, it can be restored
from your backup. However, any work done between the time of the
last backup and the data loss will need to be re-entered. As soon as
your system is installed, establish a backup procedure. Discuss the
procedure with your local FACTS office to make sure the procedure is
satisfactory.

Make sure the procedures are in place before anyone begins entering
data so that you can backup additions and changes made to any data
files.

We highly recommend daily back ups.

We also recommend backing up to tape. It is faster and more reliable
than diskettes.

Backup types

Your computer system stores different types of information.
Depending on the type of computer system installed, you will have an
operating system, a language, application programs, data, and other
miscellaneous software installed (i.e. Third Party Products, word
processing software and documents, spreadsheets, etc.)

Make sure you backup the following types of information:

- FACTS Data (your company files such as the customer files, item
files, etc.)

- FACTS Programs and Data

- Full System (all of the information above plus the operating
system, language, word processing software, spreadsheet
program, etc.)

Frequency of Backups

Remember, restoring backed up files returns your system to the state it
was in when the backup was made. All information that has been
entered or changed since the last backup occurred will have to be re-
entered. Therefore, the more frequently you back up your system, the
less information you will have to re-key in the case of a backup
restoration.
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Based on how conservative your company operates determines how
frequently you need to perform backups. The following table
illustrates our recommendation for backup frequency:

Backup Type Frequency *Tape Rotation
Data Daily 5 sets - one for each week of the
month
(one set=one tape/day)
Programs & After any software 3 sets
Data enhancement, (one set=one tape/month)
upgrade, bug fix, file B P
restructuring or,
Minimum of once a
month; run prior to end-
of-period processing
Full System Weekly and, 5 sets - one for each week of the
Before and after a month
software upgrade (one set=one tape/week)

* the calendar schedule shows when to rotate tapes

The above recommendations only apply to FACTS. If you have other
third party programs that work with FACTS or other productivity
programs, such as word processing or spreadsheet software, you need
to backup these programs and data as well.

Scheduling

Once you have planned the type and frequency of your backups,
establish a schedule (day and time) for making backups and adhere to
the schedule. Give your users advanced warning about the schedule so
they can plan accordingly.

We recommend that all users sign off the system before backup begins.
Try to perform backups first thing in the morning or at the end of the

day.

Tape Rotation

Tape rotation requires that you keep multiple sets of backup tapes and
that you alternate their use at regular intervals. If you encounter a
problem with a tape, do not use the previous set of tape(s), use a new
tape and label it to avoid confusion at the next backup.

The following schedule illustrates a recommended backup schedule
with tape rotation for a business with a five-day work week.

1-8
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Sun Mon Tues Wed Thurs Fri Sat
1 2 3 4 5 6 7
M1
&Dbia D2a D3a D4a w1
8 9 10 11 12 13 14
Di1b D2b D3b D4b w2
15 16 17 18 19 20 21
Dlc D2c D3c D4c W3
22 23 24 25 26 27 28
Did D2d D3d D4d w4
29 30 31
M2
Dle D2e & D3e D4e w5
Tapes D1a - D4a are labeled Monday to Thursday and are used for
daily backup of FACTS data. Five sets are required for a maximum of 5
weeks in a month. The next month you simply rotate back to Dla
through D4a, D1b through D4b, etc.
Tapes W1 -W5 are used weekly for full system backups. Full system
backups are scheduled for Friday of each week. When all five tapes
have been used, rotate back to tape W1.
Tapes M1, M2, & M3 are used for monthly backups of programs and
data. Monthly backups are scheduled at the beginning of the month.
When all three tapes are used, rotate back to M1, thus keeping three
complete sets of backup tapes (previous month, 2"d previous month, an
3rd previous month) for programs and data. To be very conservative,
you may want to keep a separate tape for each month of the year, thus
having twelve backup tapes verses three.
Caution: Separate your tapes according to backup type. Do not mix
backup types on the same tape!
Using FACTS 1-9




After the backup
First and foremost, verify that the backup actually happened.

Many systems ship with backup scripts that verify the tape after the
backup has been performed. Some suggested methods of tape
verification:

e Set up a UNIX script that creates an extra file. Make sure it’s
the first file on the backup tape. This file should contain the
time and date stamp of when the backup was performed. This
gives you at-a-glance verification.

e Set up a script to send UNIX mail to root. Set it up so that the
message contains a list of files that were written to the backup
tape. The System Administrator can compare the “backup”
mail each day and against the tape to make sure the two
reconcile.

¢ Look for a file with the current time and date. When a UNIX
system writes to a file, it normally updates the time and date
stamp on that file. For example, say a user entered new
customers (ARCUST) to the system prior to the backup at the
end of business Friday, July 1. If the date on ARCUST is
Friday, July 1, the backup was successful.

Another method may work better for you. In any case, make sure the
back up actually happened.

Tape Labeling

Make sure you develop a system for labeling tapes to prevent
overwrites. Labels should include the following information:

Type: DAILY BACKUP

Tape 1 of 2
Tape # D1A (Monday)
Date: (mark in pencil)

Pathname: (directory &/or files)

Off-Site Protection

Store your backup tapes off-site. This provides an additional level of
protection from natural disasters. At the minimum, store your weekly
and monthly backups off-site.
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Using FACTS

Signing on to FACTS from PCs
Users sign onto the system through a FACTS Sign On Screen.

Simply enter your

* User Code . i~foe Infor ERP FACTS

e Password

e Company Code [ ]

¢ And then press Enter I:I
on the keyboard or []
click the Sign In _
button.) : Ene

Exiting the Sign on
Screen .
There are several ways to
exit the Sign On Screen.
You can
e Press F4 at the User
Code field

e Press Esc

o Click 2 in the upper
left corner of the
screen

Click the End button.

Additional functionality

In Sign on Screen, System Administrators, local FACTS personnel and
other technical users can still get to the INSTALL menu and the BASIC
prompt by clicking on the Infor® logo.

Click on the logo. In the entry prompt that appears, type
Install to access the INSTALL menu.
or

Basic to access the ProvideX command prompt for troubleshooting and
modifications.

Using FACTS
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Using the menu system

The menu interface consists of a header, a main screen and a navigation

panel.
TT infor ERP FACTS - FACTS 2.7 Dewvelopment - Master Manu
1raFoer ERF FAL Legh Waadddell (JLWT0) | | :!
VIVFEO0 - 644 prn W7 Tigh o - Swirgn () rep T

Salan Dutan awantory Coamsl  Purehass Dutan Aty Aseout Payabla

iNfoms

s T

The header contains the system date and time, user and terminal ID, the
program name and the FACTS logo.

The navigation panel and main screen enable you to view two menus at
once — the one you're currently in and the one directly below it.

Use the navigation panel to navigate to a menu.

Use the main screen to select

Examples:
Sales Orders... This menu item links to another menu, in this case the Sales Order menu
Order Entry This menu item links to the Order Entry program.

Double-click a menu item to select it.
o If the selection links to a program, the program opens.

o If the selection links to another menu, the menu appears in the
navigation panel. Depending on which type of menu item is
highlighted (a program or a menu), the main screen may contain
buttons that lead to programs or submenus.

The navigation panel also contains a BACK button, which works like
F4. It takes you back to the menu immediately preceding the one that
appears in the navigation panel.

You can also select programs and submenu by clicking on the buttons
in the main screen.

Viewing Messages in FACTS

The Office Automation message programs are accessible from the Main
menu using the button for messages on the main

FACTS screen. You may access messages and see the number of
messages waiting in Office Automation. You can click the green
conversation balloon to access General Message Entry. You can select
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the black drop down arrow to access Phone Message Entry or General
Message Entry.

Menu time outs

System Administrators and Implementation Consultants can set the
menu system to “time out” and return to the Sign on Screen if it is
inactive for the designated amount of time.

This is a security feature that helps prevent unauthorized users from
accessing sensitive data at unattended stations.

For instance, your local FACTS Affiliate may set the menu to time out if
it is inactive for five minutes. If you take a lunch break and forget to log
off, FACTS logs off for you.

Navigating with your keyboard

Keyboard shortcuts are provided where possible as alternatives to the
mouse. We refer to these shortcuts as Alt keys since the shortcut
becomes available when you press the Alt key on your keyboard.

Example: On most OK buttons, you can press Alt+O to select the button
with your keyboard.

Arrow keys: Move you up and down through in the navigation panel
and the main screen. If the main screen contains two columns of
buttons, the right and left arrows move you between the two.

Tab key: Moves you from the navigational panel to first button on the
main screen. SHIFT+TAB performs the reverse of the TAB key.

Page up and down keys: Move you up and down four selections at a time
in the navigation panel.

Access codes

Access codes are shortcuts to different menus and programs
throughout the system. At initial installation, the system contains a
number of preset access codes for each module on the master menu and
Administrators can set up additional codes as needed (System
Management->Menu Setup—> Program E/M.)

To use access codes in the graphical menu system, type in an access
code on you keyboard anywhere in the FACTS menu system and press
Enter. As you begin typing the code, the FACTS logo disappears and an
entry box appears in its place along with the access code entered.
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Preset FACTS Access Codes

AP Accounts Payable MM  Master Menu

AR  Accounts Receivable OA Office Automation
CS  Counter Sales PO Purchase Orders
EDI Electronic Data Interchange PR Payroll

FL  FaxLink RW  Report Writer

GL  General Ledger SA Sales Analysis

IC Inventory Control SM System Management
JC  Job Cost SO Sales Orders

JS Job Stream SR Service and Repair

MC  Manufacturing Control

Access codes for standard menus

To access the Inquires menu in any module, add an I to the access code
for the main module. Example: Type ARI to access the Accounts Receivable
Inquiries menu.

To access the Reports & Prints menu in any module, add an R to the
module’s access code. Example: Type ICR to access the Inventory Control
Reports menu.

To access the End of Period menu in any module, add an E to the
module’s access code. Example: Type POE to access the Purchase Orders
End of Period menu.

To access the File Maintenance menu in any module, add an F to the
module’s access code. Example: Type SOF to access the Sales Orders
File Maintenances menu.

To access the Infrequent File Maintenance menu in any module, add
an IF to the module’s access code. Example: Type GLIF to access the
General Ledger File Maintenances menu.

S Menus may be restricted to certain users. Access codes do not work
if a menu is restricted.
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Searches “%

Searches allow you to find specific information, such as customer
number, item number, General Ledger number, etc.

Access searches by choosing the Search button (shown above) or by
pressing F2 where the search option is available.

Select information from the browser by highlighting the line and
selecting OK. You can also double click a line to select it.

@ |Customer, Search (SRCUST) - Infar E|§|E|

Options  Expott  Print
Alpha | Contact Phone Customer Class
GoTo
Filters
Kevwiords
Alpha Custormer Mame City, State [+
25 Another Mewly Added thru API
26 Another Mewly Added thru AP]
27 Another Mewly Added thru API .
dgh1 Marietta, GA
dghtest Test Marietta, GA
AUTOMATION €131 Automation Systems Supply Co Dallas, T+
Anather Ne 22 Another Mewly Added thru API
Another Ne 23 Another Newly Added thru API .
BARMES MAC 104 Barnes Machinery & Equipment Atlanta, GA
BIKES FOR 132 Bikes for Tykes Atlanta, GA
BRADLEY MA 118 Bradley Manufacturing Co. Atlanta, GA [
< >
[eyshipto ][ ok [ cancel |
Enter beginning alpha to go to

Scroll up and down in the browser with the vertical scroll bar on the
right or use the Up and Down keys. Scroll horizontally with the VCR
buttons at the bottom of the browser.

Sort orders
Use sort orders to put information in a certain sequence.

For example, if you are performing a customer search, you have the
option of sorting the information according to alpha, customer, contact,
phone number or customer class. The information that you sort by
appears in the first column of the browser window.

For instance, you may only know the customer by its FACTS customer
number (i.e., C100), so you choose to search in customer order. When
you do the system rearranges information in the browser according to
customer number and the customer number shifts to the first column
position.

To select a sort order:

Click on one of the tabs at the top of the window or press the Alt key
plus the underlined letter on the tab.

Most searches default to the alpha order if it is available, but each user
can select which sort order the search defaults to when they open it.

Go To

Using the Go To field. There are three points to remember about this
option.

Using FACTS

Tip:

When
searching by
item,
customer,
vendor or
other record
numbers,
enter the full
number in
the

Go To field.
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1. It is not a filter or a keyword. As you enter look-up information in the
Go To field, the search program advances the highlight bar to the
first closest match. All the searchable information remains in the
browser so you can scroll up or down through the entire list.

Tip: When searching by item, customer, vendor or other record
numbers, enter the full number in the Go To field.

2. This field is case sensitive. If you entered data in the system in ALL
CAPS, enter the look-up information in ALL CAPS.

3. The Go To field relates to the sort order. This is important to
remember in searches with multiple sort orders. For instance if you're
in a Customer search with the Customer Number sort order selected,
C220 is valid Go To criteria. However, if you switch to the Contact
sort order, C220 will take you to the first contact name that starts
with C.

S Entryis Beyond the Last on File. If this message appears, try entering
the lookup information in either ALL CAPS or lower case, and make
sure the lookup information you entered corresponds to the search
order you selected.

Filters

Use filters to focus on specific information. When you enter a filter, the
search eliminates from the browser any information that doesn’t match
the filter criteria.

You can select the T to access the Filter Selections dialog box.
Filter Selections Dialog Box
The Filter Selections dialog box contains any additional filter values that are available and has

a Clear button to clear out any settings that may have been entered previously. After you enter
valid values for the available filters and click the OK button, the Search generates a result set

based on the filter criteria. The visual cue that the filter is selected is % , a check mark
displayed on top of the filter button,.

If available, switch sort orders

Use sort orders to put information in a certain sequence.

For example, if you are performing a customer search, you have the option of sorting the

information according to alpha, customer, contact, phone number or customer class. The
information that you sort by appears in the first column of the browser window.

For instance, you may only know the customer by its FACTS customer number (i.e., C100), so
you choose to search in customer order. When you do the information in the browser reorders
according to customer number and the customer number shifts to the first column position.

To select a sort order:

Click on one of the tabs at the top of the window or press the Alt key plus the underlined letter
on the tab.

Most searches default to the alpha order if it is available, but you can select which sort order
the search defaults to when you open it.

Stopping the Search

You can stop the search process by selecting the Escape key. Selecting the "Escape" key (as
defined in FACTS) when the Search is generating the result set will interrupt the search and
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almost immediately return any values found matching the search criteria up through the time
the "Escape" key was selected.

A&Scrolling the browser left and right no longer restarts the search.

When a search is generating the result set, clicking your mouse anywhere in the dialog box
generates an interrupt to the search. All values found matching the search criteria up through
the time the mouse click was detected will be displayed.
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Customizing searches with Preferences
All FACTS searches have user-definable preference settings.

T 01-FACTS 7.7 Development, Prefere... |Z|@|E|

Default Sort Order v

Lines Displayed [ 11w
Save as User Defaults

[ Ok l[ Columns ][ cancel

Selectyour default sort order

Setting preferences in FACTS
Choose Options ?Preferences from the menu bar.

Default search orders: Use this setting to control which sort order
appears each time you open the search. If a search only offers one
search order, it is selected by default.

To set a default search order, select Options DPreferences from the menu
bar. Choose the sort order you want the search to default to each time
you open it and make sure the Save As User Defaults option is
selected. Click OK to return to the main Search window.

Filter preferences: For each search order, select the filters that you want
to appear. For instance, you may never use the Zip Code filter in the
Customer Search Phone Order tab. You can deselect this filter option so
that it doesn’t appear.

Number of lines displayed: Increase or decrease the number of lines
that appear in this search browser by using the spinner control next to
the input. Feature not available in character.

Save Current Preferences as User Defaults: Select this flag if you want
any preferences you have set to remain in effect each time you enter
this search. This flag also applies to Column Header settings.
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Editing columns for the search browser

L Columnn Headers - Custormer Order

Display Choices: Current Information:

Contact M M
i

SlspiTerr Mame
City, State
Contact 1
Phaone 1
Contact 2
Fhaone 2
< | |address 1
Clazs
44 |aipha hd

# of Locked Columns |1_:|

Ho['4 ‘ Cancel |

1. Choose the Column Header button in the Preferences window.

Select a column header in the left list box and use the right arrow
button to move it to the right box. The left box contains all the
possible column headers that can appear. The right box contains
the column headers that appear in the search browser. The order
in which column headers appear in the right box is the order in
which they appear in the browser.

3. Enter the Number of Locked Columns. This control enables you
to keep a number of columns “locked” so they are always in view
as you scroll horizontally.

Example: Set up your Customer Search Column Headers in the
following order: customer number, customer name, street address,
city, state, Zip Code, contact and phone number.

Then enter 2 in the locked columns field to lock customer number
and customer name.

Removing user preferences

You can remove all user preferences by selecting Options >Reset to
System Defaults in graphical.

S Resetting to system defaults clears any saved filters and resets all
search preferences back to the default FACTS settings.

Exporting search results

This option enables you to examine your FACTS search results in an
Excel spreadsheet, or you can export search results to a flat file so they
can be used in other programs, such as word processors, contact
managers, etc.

Users must be assigned the Export security code defined in SM
Company Control F/M to use this feature.
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To export search results to Excel:

Note: You must open the Excel program before exporting a search to

Excel.

1. Open a search.
2. Use the Go To and Filter fields to locate the information you want. Troubleshooting
3. Once you have the desired information in the browser, select Export >To Excel. Tip

FACTS automatically formats the results and sets up column headers. ggﬂ?tscfrﬁ'z‘r:g"s
To export search results to a flat file (ASCII): Excel, make sure
1 h Microsoft Excel is

. Open a search. loaded on your hard
2. Use the Go To and Filter fields to locate the information you want. drive and open it
outside of FACTS.

3. Once you have the desired information in the browser, select Export 2To Flat File.
4. Name the flat file. You do not have to enter the .txt extension to the file name; it will

be added automatically.

FACTS saves the flat files to ssi7\fileprt by default. To save the
file to another drive and directory, specify the path in front of the
file name.

Example: C:\ My Documents\ myflatfile.

Printing search results

You can output your search results to any FACTS printer, Windows
printer (graphical only) or to a viewer.

To print search results:

1.
2.
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Use the Go To and Filter fields to get the search results you want.

Select the Print option from the menu bar and select one of the
printer options. If you select either the Windows (graphical only)
or the FACTS printer options, choose a printer from the dialogue
box. The viewer automatically opens when you select it.
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File Maintenances

During installation and setup, use certain file maintenance programs to
enter information into the system (such as customer, item and vendor
files). Implementation Consultants and System Administrators use
other file maintenance programs to control how FACTS processes
information and which features are available to the users.

Often called F/Ms for short, these programs can be used at any time to
modify or maintain system data.

S Keep in mind that any changes you make can deeply impact your
data and the way FACTS processes this information.

Some F/Ms, such as Customer, Item and Vendor F/Ms, allow you to
keep multiple records on file in your system. When you add a new
record, you enter a unique code, called a key. These codes are later used
throughout the system to access their respective records.

Other F/Ms, such as the Static and Nonstatic Control F/Ms, are single-
record programs. These F/Ms primarily contain controls and settings
that affect the way FACTS operates.

For instance, the Sales Order Static Control F/M contains controls and
flags that activate — or deactivate — features such as Cash Drawer
Handling, Remote Order Entry and Job Costing, to name a few.

Single-record F/Ms rarely require data entry, and FACTS
Implementation Consultants are usually responsible for setting the
controls and flags in these programs.

To add a record (in multi-record F/Ms only):

1. To create new record, press L_a New.

2. Enter a unique code. These are usually alphanumeric and their
lengths vary from program to program.

3. Complete the inputs. Some file maintenances contain several tabs
of inputs. As you finish entering information on one tab, the
program automatically advances you to the next one.

4. When you complete all the inputs, press b1 save. To exit the
program and return to the main menu, press @ Exit.

To edit a record:

1. To edit an existing record, enter the record code or press Mo
display the first record on file, do display the previous record
on file, ®to display the next record on file, or Pl o display the

last record on file. You can select the —%Search button or press F2
to lookup the code.

2. Press ? Editand modify the necessary inputs.

3. When you complete all the inputs, press b save. To exit the
program and return to the main menu, press El Exit.
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To delete a record:

1.

To delete an existing record, enter the record code or press (L] to
display the first record on file, do display the previous record
on file, ®to display the next record on file, or LU display the
last record on file. You can select the — Search button or press F2
to lookup the code.

After you display the desired record, you can press #% Delete to
remove it. Choose Yes to confirm.

To browse records:

1-22

1.

In a multiple-record file maintenance, press F3 to bring up the first
record on file or enter a code.

Press 14 to display the first record on file, 4 display the
previous record on file, o display the next record on file, or

Mo display the last record on file. You can also select a VCR
button and then use Ctrl+Right Arrow or Ctrl+Left Arrow to page
through each record. In m any programs you can also select the

»Search button or press F2 to lookup the record code.
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Inquiries

Inquiries are similar to searches in that they enable you to look up
information stored in the system. However, inquiries provide much
more in-depth information than searches in what are called Views.

Each inquiry program offers different view options. For instance, in the
Vendor Inquiry you can view general information for each vendor,
including contacts, status, phone numbers, etc. You can also view
activity for each vendor, open and paid invoices, notes, payment
history and ledgercards.

You may find it helpful to have inquiries open while you are working
in entry programs so you can view information as you enter invoices,
orders, purchase orders, etc. If you are entering purchase orders, for
example, it may be beneficial to have the Vendor Inquiry program open
at the same time.

Inquiry windows consist of three sections:

¢ The inquiry browser, which enables you to select the subject of your inquiry, such as an item, customer
or account.

e The view bar, in the center of the window, which lets you quickly access different slices of information
available on the subject.

e The view area, where the information appears. The view area may present display-only data or it may
present a list box. In most cases, list boxes enable you to get more detail on each line item listed. Views
can also be opened as separate windows (in graphical only). Choose Options 2Open View as Window.

Inquiry with display-only view

- - T 01-FACTS 7.6 Development, AP ¥endor Inquiry - Alpha Order (AP1610) - Infol o ] 53|
Flnd_ a record Wlth the GO Options  Wiew Sort By Export  Print  Help
To field. Use the Starts Set filters. A check
Wlth filter Wh_en you are ———=eqTo | & \[F)—— mark indi(.:ates
sorting by unique IDs, Alpha Vendor endor Name City, State = filters are set
such as vendor number or :
H ATLANTA CR U113 Atlanta Crane & Hoists Doraville
item number. ANTA GA U111 Atlanta Gas Company Atla > GA =
/ m Codes Contacts Ger Ledgercards Open Docs Arrows on the VieW
Available records " S bar indicate more
_are Il'Sted in the Opened  11/30/:2005 ayrent Current 00 :\Z‘;:’Iza;e
|an|ry browser. ast Invoice High Balance 1099 00 !
Iwoice Fayments Distc Taken Dist Allowahle
T 00 £0 00 00
¥TD K] il Kili] Nl
Use the VCR buttons to=| e 00 0 00 . )
i i i ; ’ : ’ : Activate Sync to
view additional information -
in the browser. . getreal-time
inquiry information
[Ent§r beginning alpha to go to u as you work in
entry programs.
Select the type of The view area displays
information you want to information for the record
look up from the view bar. and view highlighted.
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Inquiry with list box view

T 01-FACTS 7.6 Development, AP Yendor Inquiry - Alpha Order (APIG10) - Info =|0] x|

Options ¥iew SortBy Export FPrint Help

- \

Alpha Wendor Wendor Name City, State -
ATLANTA CR U113 Atlanta Crane & Hoists Doraville, GA
ATLANTA GA U111 atlanta Gas Company Atlanta, GA =
. ,

a m Codes Contacts General Ledgercards. Open Docs

Date Balance
Opened 117302005 Last Payment Current
Last Invaice High Balance 1098 00

M Payments Disc Taken Disc Allowable
[ v 0 0 00 00
Double click to see Y10 0 0 0 0
details on each line item PYR 0 0 0
or use the Line Detail
button.

\Emer beginning alpha to go to

N

Using inquiries

1. Look up the record on which you want to inquire with the Go To
input.

In the Vendor Inquiry, for example, enter a vendor number, alpha
lookup or beginning characters of a vendor’s name.

You do not need to press the Enter key to select your inquiry focus. Just
highlight the desired line item. Some inquiries offer multiple sort
orders, which can be accessed from the Sort By menu option.

Using the Go To field.

1. It is not a filter or a keyword. As you enter look-up information in the
Go To field, the search program advances the highlight bar to the first
closest match. All the searchable information remains in the browser so
you can scroll up or down through the entire list.

2. This field is case sensitive. If you entered data in the system in ALL
CAPS, enter the look-up information in ALL CAPS.

3. The Go To field relates to the sort order. This is important to
remember in searches with multiple sort orders. For instance if you're
in a Customer search with the Customer Number sort order selected,
C220 is valid Go To criteria. However, if you switch to the Contact sort
order, C220 will take you to the first contact name that starts with C.

S Entryis Beyond the Last on File. If this message appears, try entering
the lookup information in either ALL CAPS or lower case, and make
sure the lookup information you entered corresponds to the search
order you selected.

Press CTRL + €or = or the horizontal scroll bar to scroll horizontally
to view additional inquiry browser record information.

2. Select an inquiry view.

To select a view, press Shift + = and Shift + € to change the view to
the left or right. You can also choose a view option from the view bar
by using the << (left) and << (right) arrow keys on the screen or select
View from the menu bar and select a view from the dropdown menu. If
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Sort list box
information by clicking
on the column
headers.

:\ Use the horizontal

scroll bar to see
additional information.

Tip

When searching by
item, customer,
vendor or other
record numbers,
enter the full
number in the

Go To field.
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line detail is available, select a line and choose the Line Detail button or
double click the icon at the beginning of the line.
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Sorting in list views

Some views, such as open or past document views, can contain large
lists of records that may take a long time to load.

The System Administrator or FACTS Affiliate determines how many
documents the browser should list at a time.

To help sort through these lists quickly:

Enter a specific record to view in the Starts From field.

Select the M button to return to the top of the list.

Select the *® button to load the next group of records into the browser.
Interrupting the file load in a list view:

Click on the Interrupt Load box to start viewing records in the browser.
Select the ®to load the rest of the records.

Inquiry menu options and other features

View menu

Use the View menu to select different inquiry views or select the Notes
Entry feature (see “Entering notes in inquiries”).

Sort by menu (if available)

Some inquiries allow you to sort records in different order. For instance
the Vendor Inquiry enables you to sort vendor records by vendor
number, vendor alpha lookup or vendor name.

Use the Sort by menu to select a sort order.

Options menu

The Options menu allows you to

o Set filter values

e Save filter values

e Set inquiry preferences

e Reset preferences and filters to system defaults
e Set view preferences

e Open views as separate windows
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Setting filter values

Use filters to help you refine your search for a record.
Choose Options 2Filter Values from the menu bar or click the Filter

button at the top of the screen.

Inquiries provide two
keyword filters.

Press the operator
button to toggle
between and and or.

Use and to search for
records containing both
key words.

The other filters available
to you change depending
on the inquiry.

T 01-FACTS 7.7 Development, Filter Selections (S#C... [~ |[B][X]

Class
Slspiarr
ok ][ cisr ][ cancl
Enterthe Class to limit search ta, F1-Clear, F2-Search

Press OK to accept the filters entered.

Press Clear to remove any existing filters.
Press Cancel to exit the Filter Values window without saving changes.

To save filters for future use choose Options >Save Filter Values from

the menu bar.

< Filter values are specific to each user. Any filters you save will be
available to you, but not other users on the system.

Using FACTS
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Setting inquiry preferences

Inquiry preferences are similar to search preferences. This function lets
you personalize certain inquiry functions to meet your day-to-day
needs.

Choose Options 2Inquiry Preferences from the menu bar to access

preferences.
Choose the sort order Default Search ord
that you want selected 57, ## U0 9K
each time you enter the roRTT Cancel
. . antac —
inquiry. @® vendar Number Colurmn Headers... -
Select Column
Current Preferences Headers to

Check the current [V Save As Usar Defaults customize the
preferenc_es flag to inquiry browser.
save settings as your Filters
user defaults. Class

Alpha Crder: |7
Choose which filters ~ ——<aniactorder v
you want to appear in Wendar Mumber Order: 3
the Filters window.

Column headers

L;# Colurnn Head wdor Murnber Order

Move header titles from the
Display Choices list box to Display Choices:
the Current Information with
the arrow buttons in the
middle of the screen. The
double arrows move all titles
at once. You can also double
click a title to move it from
one box to another.

Columns appear in
the inquiry browser in
the order that they
appear in the Current

Information list box.

Wendor Mame

s

City, State
Contact 1

2=

Lock columns so they
remain visible when you T Columns:|1_j|
scroll horizontally. In this -
case Vendor will remain

visible as you scroll through ok |
the other columns.

To reset preferences and filters to the system defaults, choose
Options 2Reset to System Defaults.

Cancel |
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Setting view preferences

Inquiries such as Item Inquiry include close to 25 views. Use view
preferences to quickly access the views you use most and hide the
views you don't use at all. View preferences are specific to each user.

EE"-.-"iE‘ Freferences

To qUICkly access a view Select an Inquiry View and set its
you use most often, attributes on the right.

choose the view in the list
box and select Favorite.

The views you set as
favorites appear at the top
of the view menu and the )

beginning of the view bar E:E;”;E;mzt

in the order you select 0K Cancel |
them. Click OK.

To hide a view from the

. . Select an Inquiry View and set its
view menu and view bar, attributes on the right.

choose it in the list box
and select Hide.

Hide
[~ Faworite

o] Cancel

Smart Views. When this feature is turned on, FACTS tracks which
views you use most and places them at the top of the view menu and
the beginning of the view bar.

The system determines your favorite views by tracking how many
times you hit (or select) a view.

Tip: You must be in a view for at least five seconds for it to count as a
hit. That prevents FACTS from mistaking views that you quickly flip
through as favorites.

When Smart Views are on, FACTS prioritizes your favorites in the
following order:

1. Views you marked as favorites in the View Preferences window.
2. Number of Smart View hits in descending order.

3. The view order set in the SMVIEW Developer’s Tool by your
Affiliate or System Administrator.

To use Smart Views:

Choose Options 2Smart Views to use this feature. Select it again to turn
it off.

Choose Options 2Reset Smart Views to remove any usage information
the system has stored.

The Sync feature and Open Views as Windows

Sync is a method of connecting the entry programs with information
displayed in customer, item and vendor inquiries. It is a helpful feature
because it enables you to get real-time information such as customer

Using FACTS
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balances, vendor balances and warehouse quantities, while you are
working in entry programs.

You can initiate Sync from the following programs:

e SO Customer Inquiry (SOI1610)
AP Vendor Inquiry (AP1610)

e AR Customer Inquiry (ARI610)
IC Item Inquiry (ICI610)

< Inquiries are synchronized on a per user basis. In other words, if
you are signed on to FACTS in one window with one name and signed
on in another window with another name, it will appear as if the Sync
function is not working.

To use Sync:
1. Open the inquiry and entry programs you want to use.
2. In the inquiry window, press the Sync button.
3. At this point you can choose to view information from the main
inquiry window, or you can open views as separate windows.
To open a view as a separate window, first select it and then choose

Options 2Open View as Separate Window. To open additional view,
repeat these steps.

4. Minimize the main inquiry window and, if necessary, arrange the
separate view windows on your screen. (The next time you open
this inquiry, FACTS will open the same views in the same position
in which you placed them.)

To turn off the Sync feature press the End Sync button.

Technical note

While Sync mode is activated, the inquiry program will examine a file
called SMUSED approximately every three seconds. This file contains
the last customer number, item number and vendor number input in
Sales Order Entry. If this number is different than the one currently
being displayed in the inquiry, the inquiry will change its display to
show information on this new customer, item or vendor.

Entering notes in inquiries
Notes are useful for documenting miscellaneous information about
each vendor, item, customer document, or account used in FACTS.

For Item Inquiry (ICI610), AP Vendor Inquiry (ARI610), PO Vendor
Inquiry (POI610), or Customer Inquiry (ARI610), select Options=>Item
Note Entry, Vendor Note Entry, or Customer Note Entry respectively to
enter or modify notes for the specified item, vendor, or customer in the
Note Entry (SME710) program.

1.  Access the Notes Entry window in Inquires.
Choose View 2Notes from the menu bar.

Any notes on file for the selected record will appear in the Notes
window. If no notes exist, the system asks Enter notes for this
[record]?

2. Enter Y to begin entering notes.
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You can enter up to 70 characters on each line and up to 99 lines for
each record (assuming the lines are incremented by 10).

Start a new line by pressing the Enter key.

Press F3 when you are finished entering notes.

Once notes have been added, or if notes already exist, the following
options are available:

#

F4

Line number to change. Notes may be changed or deleted by entering the
line number. Enter whether to Change or Delete. If D is entered, the line is
deleted. If C is entered, enter text (up to 70 characters). During this change
routine, F1 defaults to the currently displayed value of the input. F3 ends
entry of lines. F4 backs up to the line number; enter the new line number. If
a new line number is added, the old line number is deleted. F2 allows you to
change the number increments (1-10). F4 backs up to the main input.

Lists line numbers. A limited number of line-numbers appear on the screen
at any time. The list function allows line-numbers to be redisplayed. Enter
the beginning line number to list.

Adds a line number. New line numbers may be added as needed. F3 ends
entry of lines. F4 backs up to the line number, enter the new line number. F2
allows the user to set the line number increment (1-10). F4 (from line
number) will back up and delete the previous line.

Moves a line number. Enter beginning line number to move. Enter ending
line number to move. Enter line number where text will be moved (existing
lines will be replaced). One line at a time or blocks of lines may be moved.

Deletes a line number. One line or several lines of notes can be deleted at
any one time. Enter beginning and ending line numbers to delete. Enter N
or YES to delete. CR defaults to N.

Exits the Notes Entry window.

Refer to the How to enter and maintain notes for AR documents, transfer tickets,
customers, items, or vendors and the Note Entry (SME710) topics in Chapter 5, Security

System of the System Management Users Guide for step-by-step instructions on using the
Notes system in FACTS.

Using FACTS
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Using the Notes System in FACTS

Use Note Entry (SME710) to enter and maintain notes for AR
documents, customers, items, IC transfer tickets (header and lines), and
vendors.

You can also access notes directly from the main screen of programs
that use the 3-Level Entry Driver instead of requiring a menu option.
The programs include: Transfer Entry (ICE320), Shipment
Confirmation (ICE 330), Receipt Confirmation (ICE340), SO Quote
Entry (SOE110), Order Entry (SOE210), Order Confirmation (SOE310),
Direct Invoice Entry (SOE510), Credit Memo Entry (SOE330), Counter
Sales Entry (SOE510), PO Entry (POE120), PO Receipt Entry (POE210),
and Non-PO Receipt Entry (POE220). On the left side of the line item
browser, you can select:

C.. to access Note Entry (SME710) for the customer specified in the
program.

L) to access Note Entry (SME710) for the item highlighted in line item
browser.

V. to access Note Entry (SME710) for the vendor specified in the
program.

D. to access Note Entry (SME710) for the transfer header record
specified in the program.

L. to access Note Entry (SME710) for the transfer line record
highlighted in the line item browser.

Refer to the How to enter and maintain notes for AR documents, transfer
tickets, customers, items, or vendors and the Note Entry (SME710) topics in
Chapter 5, Security System of the System Management Users Guide for
step-by-step instructions on using the Notes system in FACTS.

1-32 Using FACTS



Reports, Registers and Prints

There are three types of reporting programs in FACTS.

Report programs print information in a specific format, but they do not
update the system. An example is the Open Receivables Report, which
lists all the open receivables in the system along with other information

Print programs output to forms, such as checks, 1099s, invoices,
purchase orders, bills of lading, etc.

FACTS Report Formatter

The Report Formatter brings more flexibility, convenience and
functionality to FACTS reports by allowing you to customize changes
to FACTS report output without the modification of standard code.
FACTS Report Formatter allows you to expand their report output
options in a variety of ways to further enhance the way they gather
information from FACTS.

The Multiple Output option also allows you to print to more than one
output for each instance of a report. For example, a report can print to
Excel, the viewer, and to a printer all in one print run. To access the
multiple output feature simply choose the Multiple option from the
Print Options screen.

The FACTS Report Formatter also supports supply chain management
needs by providing report output to XML. You can print directly to a
TCP/IP port or to a file with customized XML tags for each supply
chain partner.

Those reports that use the Report Formatter can take advantage of new
output types. Properly configured, you can print reports to:

Excel

XML (Can print to TCP/IP port)

ASCII Delimited (Can print to TCP/IP port)

Other (Programmer defined)

HTML to a file

You can manage security concerns for the Report Formatter by placing
a security code on any field to prevent it from printing on the report for
unauthorized users.

Setting Up General Ledger Breaks for Report Formatter

When setting up GL breaks in Trial Balance Total Breaks F/M

(GLF960), each set of Total Group GL breaks must include the entire
range of GL numbers.

For example, if you have GL numbers that range from 1000 to 4000 and
want to enter a break at GL number 2500 for Total Group 1, you must
also enter another break for Total Group 1that would include the
highest GL number, in this example, 4000.

The same is true for any Total Group entered. So, if you enter a break
for Total Group 2 that ends at GL number 2000, you would need to
enter another break for Total Group 2 that ends at or beyond GL
number 4000.
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Failure to enter the breaks as described will result in formatting
problems with the report.

Note that prior to this report being converted to use the Report
Formatter, the above requirement did not apply. This requirement is a
result of limitations introduced by the Report Formatter.

FACTS Report Registers

Registers print information and then provide an optional update, which
posts the register information to the appropriate files. For example,
after invoices are printed, they print on the SO Daily Sales Register. If
you update the register, the invoices then post to the open receivables
file, sales tax file, etc.

Most report, print and register programs allow you to

o Select the order in which you want the information to print,
o Set a range of information to print and
o Edit properties, which vary with each report.

For example, the AR reports give you the option of printing in
customer number, alphabetical, salesperson/ territory or customer class
order. If you choose to print a Customer Listing in customer class order,
the report will sort and print all of the customers by class.

Once you select an order you can then choose the beginning and
ending record that you want to print. The system always defaults to
FIRST and LAST. These two fields enable you to filter your report by
entering ranges.

In the Customer Listing example, you could enter Retail for beginning
class order and Retail for ending class order to generate a report listing
just your retail customers.

In addition to order and range, all reports and prints have a variety of
properties that enable you to fine tune your reports.

Once you have answered all the questions in the report, click OK or
press Enter (CR).

Most FACTS reports print in 132-column paper (11 %2 x 14 inch paper).
However, some reports, such as the Chart of Accounts, print on 80-
column paper (8 Y2 x 11 inch paper).

The END OF INPUTS statement indicates where 80-column paper may
be used.
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The following information appears on each page of all reports, except
GL financial reports:

*  the time and date the report was printed

*  the user

*  the terminal from which the report was run
company name

report name

*  program name

*  page numbers

*  sort order

beginning and ending range

Using FACTS 1-35



Using print options

In each report, you can select the type of output device to which the
report should print, select or deselect beginning and ending form feeds
and adjust the number of lines in the top and bottom margins.

Print options can be set each time you run the report by selecting Print
Options >Properties.

To save time, you can also save print options in templates. For instance,
you can create one template so a report outputs to a printer, create
another template so the same report outputs to a Fax and then create a
third template so the report outputs to the viewer so you can preview it
on screen.

T |01-FACTS 7.7 Development, Print Options (SMR997) - Infor 9 =(E3]
Print Ta

Printto v
Frinter 0 wind¥ Laser

File

Copies 1 Layout Standard
Margin Setting=s
Top Margin v Bottam Margin 5w

End form feed

!o

Begin form feed

ok [ mutiple ][ cancel

Selectwhere to printthe report

Inputs
1. Print to OPTION

In FACTS, you can output reports to a printer, viewer, flat file or you
can output to other software packages, such as VSI-Fax or Archive.

Printer gives you access to any of the FACTS printers set up in Printer
F/M. In graphical, select the printer from the dropdown list. In
character, continue to the Printer/File field and press F2 to search the
list of available printers.

Viewer enables you to review a report on screen. Both the graphical
and character viewers have search and scrolling capabilities. The
graphical viewer is also equipped with print capabilities, as well as a
clipboard feature.

File lets you print the report to a flat file format. This enables you to
import report information into other software programs such as
spreadsheets, databases, word processors. You can also attach the flat
files to e-mail messages. FACTS automatically saves flat files to a folder
called fileprt. To save the file somewhere else, preface the name of the
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file with a directory path. For example, C:\ My
Documents\ agedtriall.txt.

Fax sends the report information to VSI-FAX, giving you desktop
faxing capabilities. This option is only available on systems using the
Faxlink module. If you have questions about this feature, contact your
local FACTS Affiliate.

Archive is only available on systems using Archive™ software by
Designed Data Systems, Inc. This is an on-line storage and retrieval
system that lets you automatically build a library of important
documents.

For reports with multiple output options, the system also displays any
custom templates and outputs created using the FACTS Reports
formatter.

2. No. Copies

Enter the number of copies to print of the report. You can specify the
number of copies for any output except fax, email and Archive.

3. Layout

From the personal custom layouts and system layouts that are
available. Custom Layouts can be chosen when the report is run from
the Print Options or the Multiple Output Selection and can be saved
into Templates.

Margin Settings
4. Top Margin

Enter the number of lines in the top margin. All FACTS forms print 53
lines per page by default, leaving a top and bottom margin of 5 lines
each. You can adjust the number of lines in the top and bottom margins
from 0 to 20. The default is 5. Keep in mind that if you increase or
decrease the number of lines in the margin, the number of lines in your
report will inversely decrease or increase.

5. Bottom Margin

Enter the number of lines in the bottom margin. All FACTS forms print
53 lines per page by default, leaving a top and bottom margin of 5 lines
each. You can adjust the number of lines in the top and bottom margins
from 0 to 20. The default is 5. Keep in mind that if you increase or
decrease the number of lines in the margin, the number of lines in your
report will inversely decrease or increase.

5. Begin with form feed

Indicates to the system that you want to print a blank form at the
beginning of reports.

6. End with form feed

Indicates to the system that you want to print a blank form at the end of
reports.

7. Multiple option

Use the Multiple option to display the Multiple Output Selection
screen. For each output, you can choose the type of output and any
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applicable information, like Printer Number, File Name, Number of
Copies, Standard or Custom Layout (see Custom Layouts below), and
margin and form feed preferences..
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Setting a default printer in Reports

Use the Set Default Printer (SMR999) program to set the default printer
for the specific report. This setting is specific to the user that set it and
company in which the user is working. In the My Default Printer field,

enter the printer id that you want to use as the default. Press F2 or ~* to
search. The program displays the system-wide and company-wide
printers if they are set.

You can access this screen from the Print Options->Set Default Printer
menu option in Report programs.

T 01.FACTS 7.7 Dewvelopment, Set Default Printer (SME999]): - lnfor

Sething wour defzult prinder for Groder Siatus Report (SORT20)

My Dfault Prihar g | [C4] Print to HTML
Syslem-vide Dafault Hot set
Cormpany 01 Default Hot set

[ook ][ coner ]

Enteryour personal default printer far this program, F2-Search
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Multiple Output Selection Screen

Use the Multiple Output Selection Screen to choose the type of output

and enter any applicable information, like Printer Number, File Name,

Number of Copies, Standard or Custom Layout (see Custom Layouts
below), and margin and form feed preferences for each output you

select.

When you select the Multiple option on the Print Options screen, the
system displays the selected Print To option information as the default
in the upper portion of the screen.

Note: If a FACTS report program is configured to use the FACTS

Report Formatter and more than one print or output option exists for
the report, the system displays the Multiple Output Selection screen
instead of the Print Options screen.

4

003 Wiewar

Printto
Frinter
File
Mo, Copies Layout
Top Margin Bottorm Margin
Ln#  Frint To FrinterOutput Code File/TCFIF Copies
001 Printer Wiindx Laser 3
002 Excel 1

Cancel

J

Done

Inputs for Multiple Output Selection

To modify this information, highlight the Print to option in the browser

in the lower portion of the screen and select the Ficon. To add a new

output selection for the report, select the ¥ icon

Print to OPTION

In FACTS, you can output reports to a printer, viewer, flat file or you
can output to other software packages, such as VSI-Fax or Archive.

Printer gives you access to any of the FACTS printers set up in Printer

F/M. In graphical, select the printer from the dropdown list. In
character, continue to the Printer/File field and press F2 to search the
list of available printers.

Viewer enables you to review a report on screen. Both the graphical
and character viewers have search and scrolling capabilities. The
graphical viewer is also equipped with print capabilities, as well as a

clipboard feature.
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File lets you print the report to a flat file format. This enables you to
import report information into other software programs such as
spreadsheets, databases, word processors. You can also attach the flat
files to e-mail messages. FACTS automatically saves flat files to a folder
called fileprt. To save the file somewhere else, preface the name of the
file with a directory path. For example, C:\ My

Documents\ agedtriall.txt.

Fax sends the report information to VSI-FAX, giving you desktop
faxing capabilities. This option is only available on systems using the
Faxlink module. If you have questions about this feature, contact your
local FACTS Affiliate.

Archive is only available on systems using Archive™ software by
Designed Data Systems, Inc. This is an on-line storage and retrieval
system that lets you automatically build a library of important
documents.

For reports with multiple output options, the system also displays any
custom templates and outputs created using the FACTS Reports
formatter.

2. No. Copies

Enter the number of copies to print of the report. You can specify the
number of copies for any output except fax, email and Archive.

3. Layout

From the personal custom layouts and system layouts that are
available. Custom Layouts can be chosen when the report is run from
the Print Options or the Multiple Output Selection and can be saved
into Templates.

Margin Settings
4. Top Margin

Enter the number of lines in the top margin. All FACTS forms print 53
lines per page by default, leaving a top and bottom margin of 5 lines
each. You can adjust the number of lines in the top and bottom margins
from 0 to 20. The default is 5. Keep in mind that if you increase or
decrease the number of lines in the margin, the number of lines in your
report will inversely decrease or increase.

5. Bottom Margin

Enter the number of lines in the bottom margin. All FACTS forms print
53 lines per page by default, leaving a top and bottom margin of 5 lines
each. You can adjust the number of lines in the top and bottom margins
from 0 to 20. The default is 5. Keep in mind that if you increase or
decrease the number of lines in the margin, the number of lines in your
report will inversely decrease or increase.

5. Begin with form feed

Indicates to the system that you want to print a blank form at the
beginning of reports.
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6. End with form feed

Indicates to the system that you want to print a blank form at the end of
reports.

7. Multiple option

Use the Multiple option to display the Multiple Output Selection
screen. For each output, you can choose the type of output and any
applicable information, like Printer Number, File Name, Number of

Copies, Standard or Custom Layout (see Custom Layouts below), and
margin and form feed preferences.

In the browser in the lower portion of the field, the system displays any
existing or newly added Print To/Output options. You can highlight a

Print To/Output line and select the &% ion or the Delete key to delete it.

When you have finished adding/editing/ deleting outputs for the

report, press the b icon to save your changes and the Done button to
return to the report. Press the Cancel button or C to exit without saving
your changes.

Tip: Outputs Defined

The difference between a printer (defined in Printer F/M) and an
output option (as defined in the new Output Options F/M) is that
output options have expanded functionality. Advantages are:

Printing to new output types

When creating a report as a file, an administrator can control file output
to always be placed on the client PC or always on the server

When creating a report as a file, an administrator can control what the
filename will be with run-time replacements (see below for an
explanation of what these are).

Output can be customized with open, close, post-open, pre-close, and
post close procedures.

Regular printers (printers set up in Printer F/M) can still be used.
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Customize Report (SMR999.U)

Use the Customize Report program to associate formats, custom
layouts, xml tags and tiers to reports. You can access the Customize
Report program from Custom Report Layout menu.

Custom Layouts can be chosen when the report is run from the Print
Options or the Multiple Output Selection and can be saved into

Templates.
N\ 01-FACTS 7.4 Maintenance, Customize Report (SMR999.U)
File Help
Program
Farmat Stock Status
Lavaut danna's layout
Cescription Wan Width
Report XML Tan Format:ML Tag
Tier 011 Item
X
Suppress Printing Totalg Only  ©- Use Default U
Beg of Tier  o. use pefault = Endofline o usepefaut = EndofTier oo uUsepefaut  w
Frint Count  ©- Use Default  w Frint Colurmn Headers at Top D- Use Detault
Tier¥MLTag  item_tier Line XML Tag  item

Description Wariahle Tier XML Tag

Suppress printing this tier? (DN

Inputs for customizing reports

The system displays the report program name at the top of the screen
as the default.

1. Format

Select a format to associate with the customized report. For each
format, users can create a custom layout (a format is a way that the
report is run, like a sort order, or summary vs. detail). It's important to
note what report elements make up a format for that report. For

instance, if you customize the Customer Listing’s General Info format,
those changes will not apply to the Customer Listing’s History format.

2. Layout

Enter a layout to use to customize the report. To create a new layout,
select the P icon. To search for an existing layout, select the —% icon.
To copy an existing layout, select the & icon and the select a layout to
copy.

3. Description

Enter a description of the report layout.

4. System Layout

Indicate whether you want this report layout to be available as a system
layout.
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5. Max Width

Enter the maximum width in columns for the report layout.
6. Report XML Tag

Enter the XML tag for the report. (This is particularly useful for supply
chain management needs.)

7. Format XML Tag

Enter the XML tag for the report format. The report format XML tag
allows to print directly to a TCP/IP port or to a file with customized
XML tags for each supply chain partner.

Tier Section

Each format contains tiers — the different groupings that contain data
elements on the report. You can edit the tiers by highlight a tier in the line

o

item browser in the lower portion of the screen and pressing the | icon.

You can edit the following inputs for each tier:
8. Suppress Printing;:
Use the dropdown list to indicate how to suppress printing. You can
select from:

D-Use Default— None of the tier’s fields will be printed, but the records
will be processed. Sub-tiers will not be suppressed.

Y-Yes —Suppress Printing.

N-No —Print This Tier

9. Totals Only

Use the dropdown list to indicate how to print totals. You can select
from:

D-Use Default— Print only a total line for each tier.

Y-Yes.

N-No

10. Beginning of Tier:

Use the dropdown list to choose spacing preferences for the beginning
of the tier. You can select from:

D-Use Default.

N-Nothing

1—1 Line Feed

2—2 Line Feeds

3 —3 Line Feeds
P —Page Break

11. End of Line:

Use the dropdown list to choose spacing preferences for after each line.
You can select from:

D-Use Default.

N-Suppress LF
L—Line Feed
1—1 Blank Line
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2 —2 Blank Lines
P —Page Break

12. End of Tier:

Use the dropdown list to choose spacing preferences for the end of the
tier. You can select from:

D-Use Default.

N-Nothing

1—1 Line Feed

2—2 Line Feeds

3—3 Line Feeds
P —Page Break

13. Print Count

Use the dropdown list to choose print count settings. You can select

from:

D-Use Default

Y-Yes.

N-No

14. Print Column Headers at Top:

Use the dropdown list to choose print settings for column headers at
the top of the page. You can select from:

D-Use Default

Y-Yes. — The headers print at the top of the page.

N-No —The headers print at the top of the tier.

15. Tier XML Tag;

Enter the Tier XML tag according to the requirements of your supply
chain partner, if applicable.

16. Line XML Tag

Enter the Line XML tag according to the requirements of your supply
chain partner, if applicable.

Note that the # icon is disabled. You cannot remove a tier from a customized report.
Press the Layout button to access the FACTS Report Designer, where you can change the
layout for each tier

Press the Security button to access the Security Entry Screen (SMR999.S), where you can
manage security for each field on the report layout. .
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FACTS Report Designer
Use the FACTS Report Designer to create Custom Report Layouts. You
can customize each report layout in many ways:
¢ Remove a field from the report
e Add anew field to the report
e Change column header titles
e Change which columns get totaled
e Change the width of fields and their header titles
e Change XML tags on a field-by-field basis for each layout

File

Report: Stock Status Report Format: Stock Status Tier: tem

T pescar o 1473 S R o o= EOMUITTED ) BAGKGRDEREN . sEmn ) BIEETD

Max Width=132

insufficient qty flag: Column=80,Row=1,idth=1

Once you create your own layout, you can name the layout and save it
for easy access in the future. The layout can be a Personal or System
layout and if desired, can be set as a user’s default layout. Report
templates will indicate which layout you prefer.

To access this screen press the Layout button on the Customize Report
(SMR999.U) screen. The system displays the report name, report
format and tier at the top of the screen as the default.

You can:
Drag and drop fields —you can rearrange the fields in each tier.

Hide fields —you can suppress fields from the report by right clicking
on the field and clicking Hide.

Add fields —you can add fields by right clicking on a blank area and
choosing the Select Field to Place Here option. The system displays the
Place Information Field Search screen where you can choose a field to
add to the report:

Note: Most fields from the files that relate to the report will be
available. For instance, the Customer Report can be modified to add
almost any Customer File or Ship-To field.

Edit fields —you can edit fields by right clicking on the field and
choosing Edit to display the Edit Field Attributes screen.
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Edit Field Attributes screen

Use the Edit Field Attributes screen to edit the fields in a custom report layout in the
FACTS Report Formatter feature.

The system displays the report program name, report format, and reporting
information (such as the extension) at the top of the screen as the default.

Stock Status Report
Stock Status
Extension - {i#00107 i pos(x0$(1,1)="5"),i#00618,1)#00619)
General
Printidth ] Frintan Continued Line 0 - Use Default

WML Tag  extension

Totaled [ - Use Default - Total Only D Use Default  w
Total Type 0. Use Default = Founding  ©- Use Default -
Farens for Med  ©- Use Default Comma for Thousands Separator . Use Defaut «

Column Header  “Extension”

HeaderWidth 1 Justification | D- Use Default  w

oK ] [ Cancel

Enter the number of characters wide to print

Inputs for customizing reports
1. Print Width
Enter the number of character wide to print for the field. You can

change the width to your preference, keeping in mind that it is possible
to truncate the data.

2. Print on Continued Line

Use the dropdown list to indicate whether to print this field when
continuing on a new page. You can select from:

D-Use Default

Y-Yes

N-No

3. XML Tag

Enter the XML tag for this field according to the requirements of your
supply chain partner, if applicable.

For numeric fields, choose from the following:

4. Totaled

Indicate whether this field should be totaled. You can select from
D-Use Default--Totaled:
N-No--Not totaled

1- Total at this level only (for example, on the Stock Status report, total
the serial/lot costs after each item)

2-Total at this and all previous levels (for example, total the serial/lot
costs after each item and then also at the warehouse level)
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3- Total at the top level only (for example, don’t total the serial/lot costs
at the item level, but do give a warehouse total for serial/lot costs)

5. Total Only

Use the dropdown list to indicate whether this field is only printed as a
total. You can select from:

D-Use Default

Y-Yes--The field on each line will not print, but a total will print after all
lines are printed.

N-No

6. Total Type

Use the dropdown list to indicate the type of total for this field. You
can select from:

D-Use Default

S-Sum,

A-Average,

M-Min,

X-Max, or

O-Count

7. Rounding:

Use the dropdown list to enter the appropriate rounding rule. You can
select from:

D-Use Default,

B-Round the field amount before adding to total, or

A -Round after all fields have been added to the total.

8. Parens for Negative

Use the dropdown list to indicate whether to parans (parenthesis)

instead of a minus (-) sigh when numbers are negative. You can select
from:

D-Use Default

Y-Yes --if you want negative numbers for this field to be expressed in
parentheses.

N-No--if you want them to be expressed with a negative sign (-).

9. Comma for Thousands Separator

Use the dropdown list to indicate if you would like commas to separate
thousands. You can select from:

D-Use Default

Y-Yes

N-No

10. Column Header

Enter the text of the header column.
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11. Header Width

Enter the width of the header text. If the text of the header is wider that
the text of the column header, the text will wrap to accommodate the
width.

12. Justification

Enter the justification of the report. You can select from:
D-Use Default

L-Left,

R-Right,

C-Center

Select File->Save to save your customized report layout, or select File->EXit to exit the
screen without saving your layout.
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Viewing reports on screen

The viewer enables you to review report information on your terminal

or screen. Viewers help you control paper by allowing you to preview a

document before you print it.

Starting the viewer. Make sure you select viewer in Print Options >Properties or the
template selected prints to the viewer. Run the report and click OK when the
program pops a dialogue box that says End of Report.

Once you click OK, the viewer automatically opens.

Opens another document in the viewer.

Saves the document as a report file.

Saves the document as a PDF file.

Printing from the viewer. Click the Printer button in
the menu bar or select File 2Print from the menu.
Select a printer and number of copies from the Print
dialogue box.

(e
A

Using the Find feature. To locate a specific date,
description or other piece of information in a report,
click the Find button or select Edit ?Find from the

menu bar.
N View single page format.
oo View the report in a 2 pages-per-viewing-area format.
D View the report in a 2 pages-per-viewing-area in a
book-style format.
03 View the report in a 4 pages-per-viewing-area format.
O] Fit the report to the page width of the viewing screen.
0 Fit the report page to the window.

re| 0 (@ ziiv = @ Magnifying the report. If the type appears too small
on the screen, click the plus button or select
View—>Zoom In. To reduce magnification, keep
clicking the minus button or select View—>Zoom Out.
You can also enter any Zoom percentage from 1 to
400%. You can also enter a specific page number in
the Page input located in the menu bar

13 View Banner Information--file properties, such as title,
file name, user name, and creation date.

To exit the graphical view, select File 2Exit from the menu bar.
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FYI

The vertical scroll
bar in the graphical
viewer enables you
to move the selected
page up and down
within the window. It
does not allow you
to scroll through the
entire document.

Use the VCR
buttons or the Page
input to navigate
through the
document.
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Using report templates

The template feature allows you to save a combination of entries so that
you don’t have to reselect them every time you run the report. Each
user can create an unlimited number of templates in any FACTS report.

Once you create templates, you can edit them, delete them or change
their properties.

In the Template Properties window, you can change the name of a
template, set it as your default template for that report, set up a default
printer for that template, select or deselect beginning and ending form
feeds and modify report margins.

The system remembers the last nine templates used and displays them
at the bottom of the Templates menu for faster access.

Both user-specific and system templates are specific to the report in
which they are created.

Creating user-specific templates

1. On the main screen, set up the report order, range and properties.
Select a printer by choosing Print Options, if necessary.

Select Templates >Create from the menu bar.

3. Name the template. Template names can be up to 35 characters
long. Make sure the System Template option is not selected. Click
OK.

Creating system templates

Follow the same steps for creating user-specific templates, but select the
System Template option.

System templates are available to any user that has access to the report
in which it is created; however not all users can create system
templates. Users must have the security rights to perform this function.

Affiliates: To set security rights, refer to the Template Security field in
SM Company Control F/M and the Security Codes field in User Code
F/M.
Selecting existing templates

1. Select Template ?Select from the menu bar.

2. In the Report Templates window, select the template you want to
use.

3. Click OK. The name of the template appears on the bottom of the
main report screen so you know which template is in effect.

Setting a default template

You can set template properties so that one template is selected every
time you open a particular report.

1. Select Template PProperties from the menu bar.

2. In the Template Properties window, select the Set as Default
Template option.

3. Click Save.
Setting a default printer using templates

1. Choose Print Options >Properties from the menu.
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2. Select the printer you want to use as your default and click OK.

3. Choose Template >Create if you want to create a new template, or if
you have a template selected, choose Template >Save Entries.

Deleting a template
1. Choose Template >Properties.

2. Select the template from the list box in the Report Templates
window and click Delete.

Clearing a template
This feature enables you to reset a template back the report’s original default values.

When you clear templates, None appears under the Template header at the bottom of the
window, indicating that a template is not selected.

1. Select Template >Clear.
Once you clear a template:

¢ You can select it again (Templates PSelect) and reset the order, range
properties and printer, or

® You can delete it.
Changing a template name

1. With the template selected, select Template DProperties from the
menu bar.

2. In the Properties window, type the new template name.
3. Click OK.

Editing the order, range and properties stored in templates

1. Select the template if it’s not selected already.

2. Change the order, range or properties on the main screen.

3. Select Templates 2Save Entries from the menu bar.

4. A dialog box will appear confirming the changes. Click OK to

return to the main screen.
Setting printer properties in templates

Each template can have its own printer properties so that you don’t
have to set them each time you print the report. However, you can
override the template print options on a print-by-print basis by
selecting Printer Options from the main report window.

1. With the template selected, choose Templates >Properties from the
menu bar.

2. Set the print options in the lower portion of the window.

3. Click OK to return to the main report window.

Using reports, registers and prints as audit trails

Once you run a register in FACTS, the information updated by that
register is no longer available in the system in that format.

An example is the AR Cash Receipts & Adjustment Register. Payments
are posted in the AR Cash Receipts & Adjustments Entry program. The
register provides an audit trail of the payments, discounts, adjustments
and miscellaneous cash posted. The register has a number assigned to

it. FACTS updates these numbers by one each time you run the register.
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Once this register runs, the information it has collected is written to
various programs within the system.

This is why all FACTS registers allow you to print a hardcopy before
you run them. The hardcopy gives you the opportunity to review the
data, catch any errors and fix the mistakes before they update registers.

They also serve as audit trails that can be used to help reconcile data
later on in the fiscal cycle, and they provide an additional source of
backup in case you lose register information.

How long you save these printouts depends your company’s needs. We
recommend that you save them in numerical order and by register

type.
General Register Format

Registers are similar to reports, with one significant difference. Where a
report only prints information, a register prints the information and
then optionally updates it to the appropriate files in the system.

Registers are found on the menu where the information was entered.
For example, in AP, documents (invoices) are entered through the
Document Entry Program on the document entry menu, and will
update a document entry file. Users then print the Document Entry &
Adjustments Register (also found on the document entry menu) which
will provide an audit trail of what documents were entered. After the
register is printed, it should be verified and if all the information is
correct it may be updated. The update posts the documents entered to
the open payables file.

Register procedures

1. Set the appropriate order, range and parameters and print the
register.

2. Review the register print-out and verify that the information is
correct before you update. If you find errors, return to the
appropriate entry or adjustment program to make the corrections.

3. If the module is set to print GL distributions, print and review the
GL distribution to make sure transactions balance. Make any
necessary adjustments.

4. Once the register and GL distribution are correct, proceed with the
update. FACTS will not allow you to update a register if a hard
copy audit trail has not been printed.

Entering information

While entering data there are a number of points to keep in mind.

At an input, the user may enter one character for each dot displayed at
the input. After entering a character for the last dot displayed, a less

than sign (<) is displayed after the last character and further entry of
data is refused. The data entered for the field is saved.

e There is a difference between a digit and a character. When the
documentation says the input is up to 5 digits it is indicating
that only numeric fields may be entered. When the
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documentation says the input is up to 5 characters, it is
indicating that any character, alpha or numeric may be entered.
There is a difference between upper case and lower case letters.
The system contains many fields that must have valid data
entered. This means that the entry must be among valid options
entered previously into a file maintenance program elsewhere
on the system.

When entering information into a field that has a preset list of
entries, a Pick List menu will be displayed. The pick list menu
will have a vertical list of options that can be used. If the field
that is being entered requires that one option be chosen, the
menu will only let you pick one option. If the field that is being
entered will accept multiple options, the menu will display an
asterisk (*) beside the options chosen.

Entering Numbers

Users may enter a number by invoking the On-Line Calculator,
doing a calculation and then pressing the F10 key to pull the
total back into the data entry section. Refer to the section titled
“On-Line Calculator” for more information.

Entering Dates
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The format mask of the date is set in the company control record
and is either American (MMDDYY) or European (DDMMYY).
When entering dates, valid dates within the mask must be
entered (i.e., always enter two digits for the month (or day), day
(or month), and year). With an incorrect entry, the input mask
is displayed in the input.

Users may enter one or two digits at the date input and the
system assumes the digits entered are the day of the current
month and year and the full 6-digit date is displayed.

Users may enter three or four digits at the date input and the
system assumes the digits entered are the day and month
(entered in correct order based on the date mask) of the current
year and the full 6-digit date is displayed.

Users may enter a date at the date input by entering a + or - and
the number of days either before or after the current date. If the
date wanted is either a week, month or year before or after the
current date, then enter a + or -, the amount of weeks, months,
or years and a w, m or y and the full 6-digit date is displayed.
Users may enter a date by invoking the On-Line Calendar and
pressing the F3 key to pull the date back into the data entry
section. Refer to the section titled “On-Line Calendar” for more
information pertaining to the On-Line Calendar.

FACTS applies a “rule of 50” logic to the FACTS programs to
expedite date processing. If the two digit year is greater than or
equal to 50, the system will assume the date to be in the 1900s; if
the two digit year is less than 50, the system will assume the
date to be in the 2000s.

During data entry, if the system is unable to interpret the date
entered, the date mask will be displayed in the prompt. If the
system is able to interpret the date entered, the date will be

Using FACTS



displayed in the prompt. Dates prior to 01/01/1800 or after
12/31/2199 are not allowed during date entry.

e FACTS programs contain 8-character and 10-character date
fields. The date editing/entry display varies slightly depending
on whether it is an 8-character or
10-character field. When editing a date, using the right arrow or
the END key, will advance the cursor to the end of the date field
and using the left arrow or the HOME key, will advance the

cursor to the beginning of the date field.
L]

While editing or viewing dates:

8-Character
Date Field

10-Character
Date Field

When entering a date in the 1900’s (as defined
by the 50-rule), the date will be displayed as ORDERED
follows: 01/02/96<

ORDERED
01/02/96 <

Use the right arrow key or the END key to
display the full 4-digit year: ORDERED
/02/1996<

ORDERED
01/02/1996<

A plus sign at the end of the date field indicates
that the year is not in the default century. ORDERED
01/02/96+

ORDERED
01/02/2096<

Prompts

The user should always read the bottom lines of the screen for the user
prompts. These are instructional messages designed to aid the user. In
every menu and program throughout the system, this prompt always
appears in the same place. It instructs users on their options. These
prompts are the key to easy operation of the system.

F4 is an option that is available for almost every input in the system.
Therefore, F4 has been omitted as an option in most user inputs in the
documentation. F4 always backs up to the previous menu, backs up to

the previous input, backs up to a new entry (when paging through F/M

programs) or exits the program returning to the menu.
Defaults

In most programs, default answers to questions are available to users to
save keystrokes on entry. These defaults may appear in one of the
following three forms:

¢ OK to update (Y/N) - In this form where there are two or more
possible answers separated by a /. If the user presses CR, the
system assumes the first possible answer displayed in the
parenthesis (). In this example, the system would assume a’ Y
(yes) response.

e NOTE: if the prompt says OK to update (Y or N) there is no
default since the / is not present. This is used to prevent users
from executing an operation in a critical program without
typing in an answer. For example, when deleting a record the
system’s default is always an N. The user must make a
deliberate effort to delete the record by typing in a YES.
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Enter beginning customer (CR-First) - In this form if a user
presses CR, the first available record in used. This allows users
to start at the beginning or go to the end of a file without
knowing the first or last record. This is mostly used in reports,
for example, printing a Customer Listing and printing FIRST to
LAST customers (i.e., all customers).

Enter warehouse (CR-01) - In this form a specific default is
displayed in the prompt. If CR is pressed, the specific answer is

used, in this case warehouse 01. These defaults are used when a

specific answer is most commonly used. For example in Order

Entry, at the warehouse prompt, when the majority of the orders

are for warehouse 01 then 01 is the default value.

In addition to the defaults above, the system is able to assign
defaults for data entry by terminal. For each terminal set up in
the Terminal F/M (in System Management), the following
defaults are assigned: warehouse, branch, department,
salesperson/territory, and printer. Once the defaults are
assigned to a terminal, whenever one of the above mentioned
fields is requested, the system automatically defaults to the
entry assigned to the terminal. For example, if the warehouse
default for a terminal is set to a remote warehouse number,
whenever data entry requires a warehouse number, as in a
purchase or sales order, the program will default to the remote
warehouse number assigned to the terminal. Terminal default
values can greatly decrease data entry errors.
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Function buttons

Following are some of the more common buttons you will find in the
FACTS graphical environment, along with explanations of the

functions they perform.

b

3
P4

L&

Using FACTS

Save changes. Always save your entries before exiting a
program or file maintenance.

Create a new record in file maintenance programs.

Delete a record. When you press this button, the system
prompts you to verify whether or not you really want to
delete the record.

Exit a program or window. In file maintenances, the
program prompts you to save changes if you did not do
so before choosing Exit.

Go to first record in the file.
Go to the previous record in the file.
Go to the next record in the file

Go to the last record in the file.

Search for information related to the selected field. If
you are in a customer field, choose this to open the
customer search. If you are in an item field, this opens
the item search, etc.

Add a line item. Most often found in entry programs
where users can enter multiple line items.

In SO Order Management Suite programs, add a new
customer. Opens the Quick Customer Add program so
users can create new customer records on the fly while
they enter orders, invoices or counter sales.

Defaults to all available values in a field. For instance,
some of the reports allow users to enter multiple
warehouse codes or route codes side-by-side. Users can
select All, rather than keying all possible entries into the
field.

In report document grids, backs up to previous cell and
deletes any document number in that cell. See Pick List
Print (Sales Orders >Orders 2Pick List Print) for an
example.

Change UM in entry programs. Usually found in line
item entry sections and line item detail windows.

In inquiries, enables you to see more detail on a line
item.

1-57



1-58

Edit a line item, usually found in entry programs or
anywhere in FACTS where line items appear in browser
windows. See Order Entry (Sales Orders 2Orders 2Order
Entry) for an example.

Set filters in an inquiry. Choose this to set or view
keyword filters, class filters, warehouse filters, etc. A
check mark indicates filters are already set.

Insert a line in a browser. Most commonly found in
entry programs where users can enter multiple line
items.

Enter no value or don’t use this field. Commonly found
in reports and file maintenance programs when the field
is not applicable.

See more options. Mostly used in reports, prints and
registers in fields in which users can enter several letters
in one field to indicate options they want to include.
Users can press this button to see what the letters stand
for. See Item Ledgercards for an example (Inventory
Control PReports & Prints Dltem Ledgercards).

Set field to full balance of order. Used in the multiple
payment sections of SO Order Management Suite
programs. Users can select one of the payment fields
and choose this option to indicate that the entire
document balance is being paid with either check, credit
card, cash, etc.

Perform a price search. Allows users to inquire about
different price levels and previous prices offered to a
customer for the selected item.

Cancel line item entry. Usually found in entry
programs.

In Vendor, Item, Customer and GL inquiries, this
indicates the Sync! feature is enabled.

Indicates the Sync! feature is disabled. Users can enable
the feature by selecting the button.

Default to system date.

Temporary ship-to. Located in most SO Entry programs,
users can choose this option to create a temporary ship-
to address for a customer.
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